**Declaration of Conformity**

Equipment Information
Description: Direct Thermal Printer
Models: DYMO LabelWriter 300, 310, 320, 330, 330 Turbo, 400, 400 Turbo, Duo, and Twin Turbo

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC (Federal Communications Committee) rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy, and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try correcting the interference by one or more of the following measures:

- Reorient the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.
- Use shielded cables to connect this device to computers.
- Consult the dealer or an experienced radio/TV technician for help.

You may find helpful the following booklet, prepared by the FCC: Interference Handbook. This booklet is available from the U.S. Government Printing Office, Superintendent of Documents, Washington, DC 20402-9325.

**WARNING** Changes or modifications to this unit not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment and void the manufacturer’s warranty.

**Certification**

This device has been tested and complies with the requirements of:

- UL 1950
- EN60950: Low Voltage Directive Product Safety
- FCC Part 15 Class B
- EN55022: Radiated and Conducted Emissions B
- EN50082-1: Generic Immunity ESD, RF, and Transient Susceptibility

**Copyright**

© 2007 Sanford, L.P. All rights reserved. Version 7.7, Revised 04/07.

No part of this document or the software may be reproduced or transmitted in any form or by any means or translated into another language without the prior written consent of Sanford, L.P.

**Trademarks**

DYMO, LabelWriter, LabelManager, and LabelPoint are registered trademarks of Sanford, L.P. All other trademarks are the property of their respective holders.
# Contents

## Chapter 1

**Introduction**

About the Software ................................................................. 1  
About DYMO Printers .............................................................. 1  
Installing Your Printer .............................................................. 1  
About Labels .............................................................................. 1  
Registering the Software .......................................................... 2  
Getting Help ................................................................................ 2  
Using this Guide ........................................................................ 3  

## Chapter 2

**Using the Label Editor**

The Label Editor ........................................................................... 5  
Creating a New Label .................................................................. 6  

## Chapter 3

**Using the Label Designer**

Starting the Designer ................................................................. 13  
Design Objects ............................................................................ 13  
Creating a New Label File .......................................................... 15  
Opening an Existing Label File ................................................... 15  
Adding an Object ......................................................................... 16  
Deleting Objects .......................................................................... 16  

## Chapter 4

**Working with Lists**

How the Address Book Works ....................................................... 17  
Using the Address Book .............................................................. 18  
Creating a New List .................................................................... 19  
Opening an Existing List ............................................................ 19  
Using Address Fixer (Windows) ................................................... 20  
Printing Internet Postage (Windows) ........................................... 20  
Using the Mac OS Address Book (Macintosh) ............................ 20  

Congratulations on purchasing a DYMO label printer. After just a short time, you will realize how many of your daily tasks will be simplified by using your label printer. Your label printer will help you to address letters; create shipping labels; label file folders, CD/DVDs, video cassettes, packages, and create name tags; and print Internet postage. With a little imagination, you will think of hundreds of ways to use the label printer to make your job easier and more efficient.

### About the Software

DYMO Label Software includes many features that make it flexible and easy to use. The software now contains two editors: Label Editor and Tape Editor. The Label Editor is much the same as previous versions of the software, allowing you to design and print DYMO die-cut labels.

With this release, DYMO Label Software includes a Tape Editor, allowing you to print labels on D1 tape printers. The Tape Editor is only available if you have a DYMO tape printer installed on your computer, such as the DYMO LabelWriter Duo or LabelManager 450. For instructions on using the Tape Editor, see *Chapter 7, Using the Tape Editor* on page 29.

In addition, DYMO has integrated the Label Software into Microsoft® Word and Excel allowing you to print labels quickly and easily from within Word and Excel. For Windows, the software has also been integrated with Microsoft® Outlook®, Palm™ Desktop, and WordPerfect®.

### About DYMO Printers

DYMO printers use advanced *thermal* printing technology to print on specially treated labels or special thermal tape cartridges. This means you will never have to replace toner, ink cartridges, or a ribbon to print labels.

In addition to our full line of DYMO LabelWriter printers, you can now print labels to DYMO USB-connected tape printers. Currently, these tape printers include the following models:

- LabelWriter Duo tape printer
- LabelManager PCII printer
- LabelManager 450 printer
- LabelPoint 350 printer

This list of supported tape printers will change as new USB-connected tape printers are released.

### Installing Your Printer

Your DYMO printer shipped with a *Quick Start Guide* in addition to this User Guide. Follow the instructions in the *Quick Start Guide* to install your printer and DYMO Label Software.

### About Labels

The only supplies you will ever need for your printer are the labels. DYMO printers use either specially coated, die-cut paper labels or D1 tape cassettes, depending on the printer model.
NOTE   DYMOS warranty does not cover malfunction or damage that may be caused by the use of labels other than labels made or approved by Sanford, L.P.. Because DYMOLabelWriter printers use thermal printing technology, you must use specially designed and manufactured labels. The thermal coatings used on labels other than labels made or approved by Sanford may not be compatible and may provide unsatisfactory printing or cause the printer to malfunction.

How long your labels will last depends on how the labels are used. Labels printed using D1 cassette tape are not susceptible to fading. However, thermal paper labels, such as those printed by the LabelWriter printer, are susceptible to fading in two ways:

- Exposure to direct sunlight, to fluorescent light for an extended period of time, or to extreme heat will cause fading.
- Contact with plasticizers (for example, labels placed on plastic ring binders) will cause fading.

In its original packaging, the LabelWriter label shelf life is 18 months. When labels are used for short-term applications (envelopes, packages, and so on), fading is not a problem. When labels are used to label files in a file cabinet, fading is very gradual over many years. Labels applied to the edge of a notebook that is then placed on a shelf in the sun will show signs of fading within a few months.

To prolong label life when not in use, keep the labels stored in a cool, dry place and in the black bag in which they were shipped.

**Registering the Software**

We highly recommend that you register your DYMOLabel Software so that you can receive customer support and product updates.

Both Windows and Macintosh users can register the software by selecting Register from the Help menu. However, the first time Windows users start DYMOLabel Software, you will be asked to register. If you choose not to register the software at this time, you will be prompted the next several times you start the program.

**To register the software**

1. Complete all of the required fields on the registration form.
2. Choose to register over the Internet or print the registration form for mail or fax registration.
   - If you register over the Internet, wait a few seconds while your information is sent to DYMOM.
3. To register by mail or fax, print the completed registration form, and mail or fax the form to the location printed on the form.

**Getting Help**

Before making labels, you should know about the various help resources available to you. DYMOLabel Software includes extensive online Help. At times in this manual you will be directed to the online Help for more detail or instructions on various topics.

**To access the online Help, do one of the following**

- In DYMOLabel Software, click Help Contents from the Help menu.
- (Windows) Click Start, point to Programs > DYMOLabel, and then click Help with DYMOLabel Software.
- (Windows) Press F1 in most windows and dialog boxes for context-sensitive help.
Using this Guide

(Windows) The **DYMO Label** menu also includes **Internet Shortcuts** that access specific areas of the DYMO Web site, including label ordering, support, and more.

These shortcuts are also available from the **Help** menu in DYMO Label Software.

**Using this Guide**

This User Guide provides instructions for DYMO Label Software on the Windows and Macintosh platforms. For the most part, the software operates in the same way on both platforms. Any differences in features, procedures, or commands are noted within the text.

This User Guide includes information for designing and printing labels to all DYMO USB-connected printers. Depending on the model of DYMO printer you have installed, some sections of this User Guide may not apply to you. The following table provides a summary of the contents.

<table>
<thead>
<tr>
<th>User Guide Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>This chapter gives an overview of the software and all the printers.</td>
</tr>
<tr>
<td>Using the Label Editor</td>
<td>This chapter gives a tutorial of the Label Editor used for designing and printing to LabelWriter label printers.</td>
</tr>
<tr>
<td>Using the Label Designer</td>
<td>This chapter includes information about the Label Designer in the Label Editor and applies only to LabelWriter label printers.</td>
</tr>
<tr>
<td>Working with Lists</td>
<td>This chapter describes the Address Book and working with lists. The Address Book can be used with all printers.</td>
</tr>
<tr>
<td>Printing Labels Using Smart Paste</td>
<td>This chapter describes how to use the Smart Paste feature for quickly printing labels. Smart Paste can be used with all printers.</td>
</tr>
<tr>
<td>Using the LabelWriter Printer with Other Applications</td>
<td>This chapter gives information about the DYMO LabelWriter Add-Ins to Microsoft Office and other applications. The Add-Ins are only available with LabelWriter label printers.</td>
</tr>
<tr>
<td>Using the Tape Editor</td>
<td>This chapter provides a tutorial and information about printing to tape printers.</td>
</tr>
<tr>
<td>Caring for Your LabelWriter Printer</td>
<td>This chapter has specific instructions for caring for your LabelWriter. Cleaning instructions for your tape printer are included in the User Guide that came with your printer. This chapter also includes contact numbers for Technical Support for each country.</td>
</tr>
<tr>
<td>Technical Specifications</td>
<td>This chapter includes technical information about both LabelWriter printers and tape printers. Also included is information about the DYMO Software Developer’s Program.</td>
</tr>
<tr>
<td>Printing Over a Network</td>
<td>This chapter describes how to print to all of the printers over a network.</td>
</tr>
</tbody>
</table>
Introduction
Chapter 2

Using the Label Editor

DYMO Label Software is a general-purpose label printing program that is specifically designed to help you get the most benefit from your LabelWriter printer. The program includes:

- Many pre-designed labels for commonly used tasks
- A built-in Designer you can use to create your own label designs (see page 13)
- A built-in Address Book that lets you save addresses or other types of lists (see page 17)
- Add-ins to print directly from the following programs:
  - Microsoft Word
  - Microsoft Excel
  - Microsoft Outlook (Windows only)
  - Palm Desktop (Windows only)
  - WordPerfect (Windows only)
  - ACT! and GoldMine (Windows only)
- A Smart Paste function allowing you to automatically print multiple labels by copying text from other applications directly into the current label (see page 21)
- Database connectivity allowing you to print from an Access, Paradox, dBase, or Excel database (see page 27) (Windows only)
- Integration with Stamps.com and Endicia for printing Internet postage (Windows only)

The Label Editor

This section introduces some basic features available in the Label Editor.

**To start the software in Windows**

- Click Start, point to Programs > DYMO Label, and then click DYMO Label.

**To start the software in Mac OS X**

- Open the DYMO Label folder and double-click.
The DYMO Label Software window appears containing a blank label.

The first time you open DYMO Label Software, you are prompted to register the software. See "Registering the Software" on page 2. You are also asked to enter your return address and select a default logo, such as your company’s logo.

Creating a New Label

This tutorial guides you through the steps necessary to create, print, and save a customized label. The best way to start is to learn how to modify one of the pre-designed labels included with the software. In this tutorial, you will customize a shipping label with a graphic.

NOTE  You can print the shipping label, used in this tutorial, on most of the LabelWriter printers. If you have a LabelWriter 300 printer, select this shipping label and follow the tutorial anyway. This tutorial will give you valuable information on how to access the various text and design objects, and change their attributes.
Choosing a Label File

The first step is to choose a label file as the basis for your new label.

To choose a label file

1. Select the arrow next to the Label Files drop-down list.
   A list of the most recently used label files appears.

2. Select the Shipping with graphic (30256) label.
   The Shipping with graphic label appears in the main window.

Changing the Graphic

The next step is to customize the graphic. As you will see in this step, each piece of information on a label is an object (for example, the return address, the recipient address, the line, and so on). When you double-click an object, a Settings dialog box appears where you can change the object’s attributes.
**To change the graphic**

1. Double-click the graphic that appears on the label.
   
   The **Graphic Settings** dialog box appears.

2. Select **File** under **Select Graphics Source**.
   
   The **Insert Image** button changes to read **Select File**.

3. Click **Select File**.
   
   The File open dialog box appears listing the contents of the default Clipart folder.

4. Select the **Miscellaneous** folder and click **Open**. The contents of the Miscellaneous folder appear.

5. Select **Comput1.bmp** from the Miscellaneous folder.
   
   A preview showing the contents of the Comput1.bmp graphic file appears in the dialog box.

6. Click **Open**.
   
   The Comput1.bmp graphic appears in the **Graphic Settings** dialog box.

7. Click **OK**.
   
   The computer graphic is placed on the label replacing the telephone graphic.
Creating a New Label

Changing the Return Address

Next, you change the return address.

**To enter a return address**

1. Click the text in the label’s upper-right corner.
   The flashing cursor appears where the default text had been.

2. Enter the following text:
   
   **CompuDoctor’s Fix It Service**
   1234 Hardware Way
   Livermore, CA 94550

3. Click anywhere outside the text object.
   The new return address appears on the label.

Changing the Recipient Address

Next, you enter a recipient’s address.

**To enter the recipient’s address**

1. Click once on the address object in the middle of the label.
   The flashing cursor appears where the default text had been.
Using the Label Editor

(Windows) To help identify objects, a hint appears when you move the pointer over an object.

2 Enter the following address.
   DYMO Corporation
   44 Commerce Road
   Stamford, CT 06902-4561

3 Double-click the address object.
   The Address Settings dialog box appears.

4 Select Below Address under Barcode Position and then click OK.
   DYMO’s address now appears as the recipient’s address on the label with a postal barcode beneath the city, state, and ZIP code.

Changing the Font

You may want to modify the font used for the recipient address or return address.

To change the font

1 Click the recipient address object. The address text is highlighted.
2 Select Times New Roman from the Font drop-down list.
3 Select B from the Formatting toolbar.
Creating a New Label

The recipient address appears in the new font and style.

Printing the Label

Now that you have customized the label, you are ready to print.

**NOTE** You can only print this shipping label on most LabelWriter printers. If you have a LabelWriter 300, review this section even though you will not be able to actually print the label.

Before you print the label, make sure:

- The LabelWriter printer is connected to your computer and turned on.
- You have properly loaded shipping labels in the printer. If necessary, see the *Quick Start Guide* for information on how to set up your printer and load the labels.

**To print the label**

1. Enter the number of copies of this label to print in the **Copies** field on the Main toolbar.
2. Click **on the Main toolbar.

Saving the Label

Now that you have created your shipping label, you can save it as a label file. Saved labels will automatically appear in the **Label Files** drop-down list.

**To save the label**

1. Click **on the Main toolbar. The **Save File** dialog box appears.
2. Enter **MyShip** as the new name for the file and click **Save**.

Notice that your new label file, MyShip, is added to the top of the **Label Files** drop-down list as the most recently used label and also alphabetically in the list of labels below.

To use a label file you created, choose it from the **Label Files** drop-down list.

**NOTE** To access your label files from the Label Files list, you must store them in the Label Files folder. A default Label Files folder is created for you when the software is installed. For Windows, the folder is located in `C:\Documents and Settings\All Users\Documents\DYMO Label\Label Files`. For Macintosh, the folder is located in the DYMO Label folder where you installed the application.

Now that you can open, edit, print, and save a shipping label, you are ready to modify and use most other label files.
Chapter 3
Using the Label Designer

The Label Editor allows you to easily design labels for your specific needs using a simple-to-use Label Designer. You can also modify any of the pre-designed label files included with the software. The Designer allows you to change the appearance and content of labels. You can add or modify text (including addresses), barcodes, sequential numbers, date-time stamps, lines, rectangles, and circles or ellipses (Macintosh). The following figures are examples of custom label designs.

Starting the Designer

When the Designer is active, the Designer toolbar appears below the Formatting toolbar.

To start the Label Designer, do one of the following
- Create a new label file. See "Creating a New Label" on page 6. The Designer toolbar automatically appears.
- With a label file open, click .

Design Objects

A label created in DYMO Label Software can contain various text and design objects. Each object has certain attributes, such as size, position, font, and so on. You can select the attributes that you want in the object’s Settings dialog box. For more information on modifying object attributes, see the online Help.

This section describes each of the objects available on the Designer toolbar.

Text

The text object is useful for displaying information that remains unchanged every time you print a new label (for example, “Hello my name is” on name badges or your return address on shipping labels).

Text objects can also be used for variable text (text that changes from label to label). This is useful for part numbers, book titles, and many other non-address items you might save as a list in the Address Book. For more information on variable text, see the online Help.
**Address**

The address object is similar to the text object, but it is designed to print information that changes with each label printed, such as names and addresses. Address objects can also display POSTNET barcodes. You can change the font settings (font, size, style, and so on) for text in address objects and control the text’s position. You can also apply special effects to the text.

Address objects are by default variable text objects. Address objects can also be fixed text objects. Address text is saved as part of the label in fixed text objects. The address is not saved with the label in variable text address objects. (See "How the Address Book Works" on page 17 for more information.)

**Graphic**

The graphic object allows you to add your company logo and other favorite graphics to labels. You can import many popular graphic formats, position them anywhere on the label, resize them, and even specify one as the default graphic. You can also copy a graphic from a graphics application (such as Microsoft Paint or CorelDRAW), and then paste it onto a label. You can import a graphic directly from a file or (Windows only) capture an image from a video device connected to your computer.

*NOTE* If you defined a default logo file, the graphic file you specified is automatically displayed in any new graphic objects you add. See the online Help for information about defining a default logo file.

**Lines**

You can use the horizontal and vertical line objects to improve a label’s appearance. Horizontal lines also function well as visual dividers on labels (for example, between the sender and recipient’s address on shipping labels). You can specify the thickness of the lines, and you can also hide lines that appear on labels.

**Rectangle**

The rectangle object, like the line objects, is primarily used as a design element to enhance a label’s appearance. A rectangle can be used to create a border around other objects. You can specify shades of gray to fill the rectangle. You can also specify the thickness of the rectangle border.

**Ellipse**

(Macintosh) The ellipse object, like the line objects, is primarily used as a design element to enhance a label’s appearance. An ellipse can be used to create a border around other objects. You can specify shades of gray to fill the ellipse. You can also specify the thickness of the border.

**Barcode**

The barcode object displays and prints a barcode on your label. You can use a barcode object to display fixed information that you enter or variable information obtained from another object. When you link a barcode object to another object, the barcode object encodes the information contained in the linked object. Furthermore, if you change the information in the linked object, the barcode object automatically encodes the new information.

For example, you may want to link the barcode object to a part number text object on a label. When you update the part number in the linked text object, the barcode object is automatically updated as well.
You can choose from many standard barcode symbologies, including Code 39, Code 128, Codabar, UPC A/E, EAN 8/13, ITF-14, POSTNET, PLANET, and Interleaved 2 of 5 barcodes. You can choose to include or exclude human-readable text (alphanumeric information) and specify the font settings for the text. You can also select the barcode size and position. See the online Help for more information about the barcode symbologies supported.

**Counter**

The counter object automatically numbers a series of labels. For example, you could use a counter object to automatically serialize a bunch of raffle tickets. You can specify text you want to appear before and after the counter (for example, “Disk # of ten”), as well as the starting number and the increments for counting (1, 10, 100, and so on). You can also specify the font settings for the counter information, as well as other attributes.

**Date-Time**

The date-time object stamps the current date and/or time on labels using any one of several pre-defined formats. As with counter objects, you can specify the text you want to appear in front of and behind the date-time (for example, “Today’s date is”). You can choose from a variety of date formats, including European formats. You can include or exclude the time and use the 24-hour time format (13:00, 22:00, and so on). You can control the font settings and other attributes for the date-time information.

**Curved Text**

The curved text object is similar to the text object, but allows you to place the text along a curve. This object can be used for placing text around the perimeter of a round CD label or for simply adding text in an arc on any label. You can choose to display the text as a full circle or as a semi-circle along the top or bottom of the label. You can also choose to mirror the text. As with the text object, the curved text object can be used as a variable text object and you can control the font settings and object position.

**Creating a New Label File**

DYMO Label Software includes a blank label file for every type of label available. When you create a new label, you select one of these blank labels as a starting point.

**To create a new label**

1. Click . The New Label dialog box appears.
2. Select a label that most closely matches the type of label you wish to create and click OK.

   The blank label opens in the label workspace and the Designer toolbar appears.

**NOTE** You can filter the number of labels displayed by selecting **Portrait** or **Landscape** in the New Label dialog box.

**Opening an Existing Label File**

To use a label file you have saved to disk, you simply open it. You can then print the label as is, or modify it to suit your needs. For convenience, the most recently saved label files appear at the top of the Label Files drop-down list.
**To open an existing label file**

1. Click \( \text{Open File} \). The **Open File** dialog box appears.
2. Select the file you wish to open and click **Open**. The label opens in the label workspace.

**Adding an Object**

When you place a new object on a label, the new object displays certain default settings. For example, new address and text objects display text describing how to modify the objects.

Although the various types of objects are different, the steps for placing the objects on a label are nearly identical. The only difference is the tool button you select from the Designer toolbar to place the desired object.

**To add an object**

1. Click the object that you wish to add on the Designer toolbar. The new object appears in the upper-left corner of the label.
2. Resize and move the object where you want it on the label using the cursor.

**NOTE** If you defined a default logo file, the graphic file you specified appears in all new graphic objects you place. See the online Help for information about defining a default logo file.

**Deleting Objects**

When you delete an object, the object’s contents (text, graphics, barcode, and so on) are also deleted.

**To delete an object**

1. Select the object.
2. Select **Cut** from the **Edit** menu.
Chapter 4

Working with Lists

DYMO Label Software includes a built-in Address Book that allows you to maintain lists of addresses routinely used to generate labels. Additionally, if you have Mac OS version 10.2 or later, you can print labels using the addresses already stored in your Mac OS address book.

You can also use the built-in Address Book to store information other than addresses. This information (for example, a list of product numbers or video titles) can be linked to a variable text object or barcode object (for example, to print a barcode label for all your product numbers).

This chapter describes how to use the built-in Address Book to create, edit, and print entries on labels. Refer to the online Help for more detailed information on using the Address Book.

How the Address Book Works

The Address Book allows you to create address or data list files. Address list entries are automatically sorted using the first line of the address. If this line is a person’s name, the entry is listed and sorted by the last name. However, if the first line is a company name, the entry is sorted by the company name. Data lists are sorted by the first few characters of each entry’s first line.

The Address Book items can be used with address and variable text objects. Address objects are by default variable text objects and the currently selected Address Book entry is displayed in the object. This means that the actual content that prints in an address object is not necessarily the same each time the label is printed. For example, if you select ten entries from the Address Book and then click print with an address label open, ten address labels will print, one for each selected entry in the Address Book. When you save an address label, only the formatting is saved, not a specific address. When that address label is opened the next time, the then currently selected Address Book entry appears in the address object.

You can, however, define an address object as a fixed address object, meaning that the actual address that is currently in the object is saved as part of the label when you save and close the label. The next time you open the label, the object contains the same address. The Fixed Address setting allows you to create and save labels for a recipient that you use frequently, but still be able to print a POSTNET barcode and check the address with Address Fixer.

A text object normally contains static text (text that is the same each time the label prints), but it can become a variable text object by selecting the Function as Variable Text object setting. A variable text object behaves in much the same manner as an address object, but without the Address Fixer and barcode features. A variable text object can be used to print labels from list entries. For example, you can print price tags from a parts list or name tags from an attendance list.

When you open a label with a variable address object or variable text object, the currently selected Address Book entry is automatically displayed. As you select different Address Book entries, each newly selected entry is automatically displayed in the object. If you then decide you want to print the currently selected address on a different label, just open the new label and the same address
appears in that label’s format (as long as the new label contains an address or variable text object). The formatting from the previous label is not copied to the new label, only the text which takes on the formatting of the new label.

**Using the Address Book**

The Address Book is displayed in a panel at the bottom of the DYMO Label main window. You can display or hide the panel using the Address Book button on the Action bar.

**To display the Address Book**

- Click or select *Open* from the *Address Book* menu.

The last list file that was opened appears in the Address Book panel of the Main window. The first time you open the Address Book, the *Sample List* entries appear.

**Using Lists with Multiple Variable Objects**

You can use the Address Book to enter information into objects that can contain variable text on the current label. Variable text objects are text objects where you have selected the Variable Text field in the Text Setting dialog box, or barcode objects. If the current label contains more than one variable object, you need to select the object into which you want the selected Address Book entry to appear.
To insert address data into a label with multiple variable objects

1. Select the list entries you wish to print.
   The Pick Variable Object dialog box appears listing the objects available on the current label.

   ![Pick Variable Object dialog box](image)

2. Select the object you want to link to the Address Book and then click OK.
   If the current label does not contain a variable object, you are prompted to open a label that does
   contain one of these objects. This prompt appears because the program automatically links Address
   Book entries to variable objects. You can still work in Address Book without a variable object on
   the current label, but Address Book will not link to the current label.

Rotating Names in Address Lists

The Address Book automatically sorts addresses by the last name. For example, if you enter the
following address:

Harrison Schreppel
5040 El Cantada
Berkeley, CA 94720-3828

The Address Book displays Schreppel, Harrison in the Entries list.
In some cases, the Address Book incorrectly identifies which name is the last name or incorrectly
identifies a company name as a person’s name. This is easily fixed using Rotate Name.

To rotate the name

1. Select the entries that are displayed incorrectly.
2. Click Rotate Name to rotate the words in the entry’s first line so that they display correctly.

Creating a New List

When you create a new list file, Address Book gives you the option of importing addresses or data
(for new address lists or data list files, respectively) into the new file.
A new list file is created with the specified name and stored in the default list file folder. The new
file name appears at the top of the Address Book panel.

Opening an Existing List

If you have more than one address or data list file, you can select the list you want to use to create
labels. Also, if you want to import addresses or data into a file, you must first open the file into
which you want to import the data.
For information on importing and exporting list data, see the online Help.
Using Address Fixer (Windows)

Address Fixer allows you to check a recipient’s address against a database of US addresses, correct any mistakes, and automatically add the complete nine-digit ZIP+4 code. Address Fixer corrects a single address at a time, so you can only use it when printing a label for the current contact. Address Fixer cannot check addresses when you print labels for multiple contacts. Address Fixer is a separate utility available from DYMO and is included on your DYMO Label Software CD-ROM.

To check your address, do one of the following

- Click ![Check Address](image). The current address is checked.
- With a contact selected, click the Check Address button from the Word, WordPerfect, Outlook, or Palm Desktop Add-in.

Visit [www.dymo.com/addressfixer](http://www.dymo.com/addressfixer) for more information about the Address Fixer utility.

Printing Internet Postage (Windows)

LabelWriter printers capable of printing on wide (2 1/4") labels are approved by the US Postal Service to print Internet postage. Currently, these printers can be used in conjunction with Endicia and Stamps.com™ Internet postage software.

To learn more about Internet postage, visit [www.endicia.com](http://www.endicia.com) or [www.stamps.com](http://www.stamps.com). If you are already an Internet postage user, you can print postage using the Endicia or Stamps.com software from within DYMO Label Software. For more information on printing postage, refer to the online Help.

Using the Mac OS Address Book (Macintosh)

If you are running Mac OS version 10.2 or later, you can print addresses you already have stored in the Mac OS address book. However, unlike the built-in Address Book, you cannot add or change the addresses in the Mac OS address book from within DYMO Label Software. You must make changes using the Mac OS address book application.

**NOTE** Make sure that your Mac OS Address Book My Card record contains your country of residence. This country information is used to determine the correct address format for your labels. Refer to the Mac OS Address Book online Help for more information about My Card.

To print from the Mac OS Address Book

1. Select Use Mac Address Book from the Address Book menu.
   You can also choose this menu item from the Address Book drop-down menu.
2. Select the address that you wish to use.
   The address is placed on the current label.

If your address book is large, you can display the addresses from a single group to locate an address more quickly.
Chapter 5

Printing Labels
Using Smart Paste

The Smart Paste command allows you to quickly print multiple labels from a list created in a word processing, spreadsheet, or other similar program.

The text and address objects can be used to print text from other applications. For the text object, you must select the Function as Variable Text Object setting on the Text Settings dialog box to copy text into this object. The address object is ready to use with Smart Paste by default.

About Smart Paste

This section describes how text from different sources can be printed on labels using the Smart Paste command.

Spreadsheet Text

When copying and pasting rows of text from a spreadsheet program using Smart Paste, each row is treated as a separate label and each cell in the row is treated as a separate line on the label.

For example, the rows in the following spreadsheet:

```
<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sanford, L.P.</td>
<td>44 Commerce Road</td>
</tr>
<tr>
<td>2</td>
<td>Newell Rubbermaid</td>
<td>108 Glenlake Parkway</td>
</tr>
</tbody>
</table>
```

will print two three-line labels: one for Sanford and one for Newell Rubbermaid.

Text File

Many programs can create a text file, such as a text editing program, a database application, and so on. When you export text from a database, you usually create a delimited file with each entry separated by comma or tab characters, and a carriage return/line feed at the end of each entry.
The Smart Paste command recognizes the delimiter characters and will insert a line break on the label. When a comma is used as a delimiter, make sure the text that contains any commas that you want to print on the label is enclosed in quotation marks. The carriage return/line feed will start a new label.

**NOTE** The separator character may be different for countries other than the United States. When using Smart Paste, the list separator character is based on the Windows list separator (or regional setting) being used.

For example, the following lines of text (delimited using commas):

```
“Sanford, L.P.”, 44 Commerce Road, “Stamford, CT 06902”
Newell Rubbermaid, 10B Glenlake Parkway, “Atlanta, GA 30328”
```

will print two three-line labels: one for Sanford and one for Newell Rubbermaid.

In another example, the following three lines of text are printed as three two-line labels:

```
Pencils
3 for $1.00

Pens
$0.50 each

Erasers
$1.00
```

**Multi-Line Text from a Word Processor**

When copying text from a word processor, you will typically have multi-line text. In this case, the text for each label is separated by either a single blank line or a carriage return/line feed.

If a blank line is contained in the text, Smart Paste reads the text as multiple labels separated by a single blank line. If no blank line is found, the text is read as multiple, one-line labels.
For example, the following two addresses are separated by a single blank line and Smart Paste will print two three-line labels.

Sanford, L.P.
44 Commerce Road
Stamford, CT 06902

Newell Rubbermaid
10B Glenlake Parkway
Atlanta, GA 30328

However, the following three lines of text contain no blank lines. So, Smart Paste will print three one-line labels.

Pencils
Pens
Erasers

Printing Multiple Labels Using Smart Paste

Printing Multiple Labels Using Smart Paste

When you use Smart Paste to print multiple labels, the labels will be formatted using the font, size, and style currently selected for the text or address object receiving the text. You can use Smart Paste to print text from the clipboard or a file.

Printing from the Clipboard

You can use Smart Paste to print labels using data copied to the clipboard.

To print multiple labels from the clipboard

1. Create a label as described in Chapter 2, Using the Label Editor.
2. Make sure you have at least one text or address object on the label.
   If using a text object for the paste, select Function as Variable Text Object on the Text Settings dialog box.
3. Copy the text you wish to print as labels to the clipboard.
4 Select **Smart Paste**, and then **From Clipboard** from the **Edit** menu. A dialog box appears telling you how many labels will be printed.

![Confirm Dialog Box]

5 Click **Yes**. The labels begin printing.

**Printing from a File**

You can use Smart Paste to print data saved in a CSV or text file.

**To print multiple labels from a file**

1 Save the data you wish to print as labels as a CSV or text file.
2 Create a label as described in *Chapter 2, Using the Label Editor*.
3 Make sure you have at least one text or address object on the label.
   If using a text object for the paste, select **Function as Variable Text Object** on the Text Settings dialog box.
4 Select **Smart Paste**, and then **From File** from the **Edit** menu. The File Open dialog box appears.
5 Navigate to and open the file you exported as CSV or text.
   A dialog box appears telling you how many labels will be printed.

![Confirm Dialog Box]

6 Click **Yes**. The labels begin printing.
Chapter 6

Using the LabelWriter Printer with Other Applications

This chapter describes how to use your LabelWriter printer with other application programs. The chapter covers:

- Printing labels from Microsoft Word using the Word Add-In.
- Printing labels from Microsoft Excel using the Excel Add-In.
- Printing labels using other Add-Ins for Windows applications.
- Using Merge Print from Database for database connectivity.
- Using the LabelWriter printer driver to print labels directly from other programs.

Add-In for Microsoft Word

DYMO Label Software includes an add-in program that enables you to quickly print mailing labels from a Microsoft Word document. The add-in works with Microsoft Word 2000, XP, and 2003 for Windows and Microsoft Word X and 2004 for Macintosh.

The Word Add-in is automatically installed as part of the DYMO Label Software. When properly installed, you will see a small LabelWriter printer button on the main toolbar of Microsoft Word. If you don’t see this icon, you’ll need to reinstall your DYMO Label Software.

Don’t worry, none of your customized label files will be changed. Simply reinstall DYMO Label Software from your DYMO Label Software CD-ROM.

CAUTION When you reinstall the DYMO LabelWriter Software, all of the pre-designed label files are also reinstalled. If you have made any changes to the pre-designed label files and have not saved the changes with a new file name, copy the changed label files to another location before you reinstall the software so you don’t lose your changes. Then once the installation is complete, copy the label files back into the Labels folder.

Using the Word Add-In

When the Word Add-in is properly installed, you will see the LabelWriter button in the main toolbar of Microsoft Word.

To start using the Word Add-in

1. Open Microsoft Word and type an address.
   To print addresses already laid out in table format, insert the cursor anywhere in the table to print all the addresses, or select only those addresses you wish to print.

2. Click on the Word toolbar or select DYMO LabelWriter from the Tools menu.
The Print DYMO Labels dialog box appears with the address from your document automatically placed in the **Recipient Address** field.

If your document contains more than one address and you want to make sure the Word Add-In uses the correct one, select the address in your Word document before you click **Print Label**.

**Printing the Address**

Once the Print DYMO Labels dialog box appears, you can select from a number of different address and shipping label files, depending on how you want the label to look.

**To print the label**

1. Select the desired label file from the **Label Files** drop-down list.
2. To change the address, edit the address in the Recipient Address dialog box.
3. Click **Print Label** to print the label.

If you are printing a shipping label file, it will include the return address that has already been defined for the file.

**Additional Windows Application Add-Ins**

In addition to the Microsoft Word Add-In, you can install add-ins for several Windows-based contact management applications. Each application is briefly described in this section and full details for installing and using the add-ins is included in the online Help.

**About Microsoft Excel, Outlook, Palm Desktop, and WordPerfect Add-Ins**

Similar to the Microsoft Word Add-In, the Microsoft Excel and Outlook, Palm Desktop, and WordPerfect Add-ins are automatically installed at the same time as DYMO Label Software. When an add-in is installed correctly, you will see a tool button in the main toolbar of the application. If you don’t see this tool button, you will need to reinstall your DYMO Label Software.

**CAUTION** When you reinstall the DYMO LabelWriter Software, all of the pre-designed label files are also reinstalled. If you have made any changes to the pre-designed label files and have not saved the changes with a new file name, copy the changed label files to another location before you reinstall the software so you don’t lose your changes. Then once the installation is complete, copy the label files back into the Labels folder.
About the ACT! and GoldMine Add-Ins

DYMO Label Software includes add-ins for ACT! and GoldMine that enable you to print contact information for your contact databases onto labels. Once you install the add-in, you can quickly print address, shipping, file folder, and other labels for the current contact, the current lookup, or for all contacts in your database.

These two Add-Ins are installed and managed through the Add-In Manager on the File menu.

NOTE  The ACT! 2005 Add-In is completely installed automatically by the DYMO Label Software installation program. You do not need to install this version of the Act! Add-In using the Add-In Manager.

Complete instructions for installing and using these add-ins is available in the online Help.

About the Database Add-In

DYMO Label Software includes a database add-in that enables you to print information from a variety of databases onto labels. Once you install the add-in, you can quickly print address, shipping, file folder, and other labels from the data in your database.

When selected, the database add-in is automatically installed when the DYMO Label Software is installed. You access the database add-in from the Merge Print from Database command on the File menu in DYMO Label Software.

The complete instructions for using the database add-in are available in the online Help.

Printing Directly from Other Applications

At times you may want to print labels directly from another program to your LabelWriter printer, without using DYMO Label Software or the LabelWriter add-ins. One example could be if you maintain address lists within Microsoft Word or Access and want to print them all on labels without importing the list to the DYMO Label Software Address Book.

Printing labels directly from applications like these is quite easy because the LabelWriter printers come with standard Windows and Mac OS printer drivers that work with virtually any application.

Detailed instructions on printing directly from Microsoft Word can be found in the online Help. Even if you are using a different application program than Word, reviewing the instructions in the online Help will give you an understanding of how to use the LabelWriter printer driver with your favorite program.
Chapter 7
Using the Tape Editor

The DYMO Label Software Tape Editor is used to design and print labels on DYMO tape printers, such as the LabelWriter Duo or the LabelManager PCII printers. Using the Tape Editor, you can print text on your D1 tape labels in a variety of fonts, sizes, and styles. You can add borders, graphics, special characters, and barcodes. You can also add a date and time stamp to your labels.

This chapter gives you an overview of creating and printing labels using the Tape Editor. For more information on any of these features, refer to the online Help.

The Tape Editor

The Tape Editor is only available when you have a DYMO tape printer installed on your system, such as the LabelWriter Duo, LabelManager PCII, LabelManager 450, or LabelPoint 350 printers.

The basic functionality of DYMO Label Software is the same in both the Label Editor and the Tape Editor, such as opening and saving files, using Smart Paste to print multiple labels, and so on. So when the Tape Editor is active, the only differences you will see are those specific to designing and printing D1 tape labels. Become familiar with all the features of the software by reading through the other sections in this User Guide.

To use the Tape Editor

1. Open DYMO Label Software.
2. Click on the left side of the main window. The Tape Editor appears with a new blank label.
Designing a Label

In this section, we will show you how to print a label for a file folder tab using the Tape Editor. You can format the label text and then save the label for future use.

When designing a label, the first items to consider are the width of the label tape onto which you will print and the length of the area where you will place the label. For this example, we will create a label that will fit on a file folder tab. The total label length must be no more than 3 1/2” (8.5 cm) and we will print on label tape with a width of 1/2” (12 mm).

To create a label

1. Start DYMO Label Software.
   The main window appears.

2. Select 3/4 inch from the Tape Width drop-down menu.
   The text area of the main window changes in size based on the tape width you select.

3. Select Fixed At and enter 3.50” in the Label Length Fixed At text box.
   Notice that the size of the input area changes on the ruler.
Designing a Label

4 Type **2005 Annual Budget Projections** in the main window.

![Image](image.png)

As the line of text becomes too long for a fixed width label at the current font size, the font size will automatically decrease to fit the text on one line.

5 To center the text, click .

6 Click or select **Save** from the **File** menu.

   The Save File dialog box appears.

7 Type a name for the label and click **Save**.

   Now let’s print the label.

8 Click or select **Print** from the **File** menu.

Now that you have created and saved your label, the following sections will introduce additional features you can use to customize your labels.

**Additional Formatting Features**

To further customize your labels, you can add borders, symbols, graphics, barcodes, and even date and time stamps. You can also choose to print the label vertically.

**Adding Borders**

You can choose to add one of several pre-defined borders to your label. When you add a border, it surrounds the text and may cause the text to decrease in size.

**To add a border**

1 Place the cursor anywhere on the label.

2 Select a border style from the **Borders** drop-down menu.

![Image](image.png)
The selected border surrounds the text. If necessary, the font size of the text is decreased to fit the label.

Adding Special Characters

You can choose to add a special character or symbol to the label.

To add a special character
1. Place the cursor at the point on the label where you want the character to appear.
2. Click ☀️ or select Symbol from the Insert menu.
   The Symbol dialog box appears.
3. Choose the font that contains the special character you wish to insert from the Font drop-down list.
   The Symbol, Dingbats, and Wingdings fonts contain many unique characters you can add to your labels.
4. Select the symbol you wish to insert and click Insert.
5. Click Close to close the Symbol dialog box.
   The character you selected appears on the label in a size that matches the text font size.

Adding Special Font Effects

In addition to the standard font styles (bold, italic, underline, and strikeout), you can make your text stand out using a shadow or outline style. With the outline style, you choose the fill pattern.
To add a shadow effect to your text

1. Highlight the text on your label that you wish to appear with a shadow effect.
2. Select Font from the Format menu. The Font dialog appears.
3. Select Shadow under Effects and click OK.

The highlighted text now appears on the label with a shadow effect.

To add an outline effect to your text with a fill pattern

1. Highlight the text on your label to which you wish to apply an outline effect.
2. Select Font from the Format menu. The Font dialog box appears.
3. Select Outline under Effects.
4. Select a fill pattern from the Fill Pattern drop-down menu.
5. Click OK. The highlighted text now appears on the label with an outline effect.

Adding a Date and Time Stamp

You can choose to add a date and/or time stamp to the label. The date and time is entered as text and will be the actual system date and time when you added the stamp to the label. For example, if today’s date is 24 Oct 2002 and you add the date to a label design today, save the label, and then open it tomorrow, 24 Oct 2002 will still appear on the label.

To add a date and time stamp

1. Place the cursor at the point on the label where you want the date and/or time stamp to appear.
2. Click or select Date & Time from the Insert menu.
The Date and Time dialog box appears.

3 Select the date and/or time format you wish to insert from the drop-down list and click OK. The date and/or time appears on the label in the format you selected.

Adding Graphics

You can add a graphic to your label from the clipboard or from a file. If the graphic is in a file, the format can be BMP, JPG, PCX, PNG, TIF, WMF, or EMF. When inserted on the label, the graphic will be scaled automatically to the size of the surrounding text while maintaining the aspect ratio.

To add a graphic from the clipboard
1 Copy the graphic to the clipboard from another application.
2 Place the cursor at the point on the label where you want the graphic to appear.
3 Click or select Paste from the Edit menu.
   The graphic appears on the label at the cursor position.

To add a graphic from a file
1 Place the cursor at the point on the label where you want the graphic to appear.
2 Click on the Standard toolbar or select Graphic from the Insert menu.
   The Open File dialog box appears.
3 Select the graphic file you wish to insert and click Open.
   The graphic you selected appears on the label.
Adding a Barcode

You can choose to add a barcode to your label. This feature can be very useful, for example, if you are labeling inventory items that will be scanned with a barcode reader. You can choose to print the barcode with or without the human-readable text.

To add a barcode

1. Place the cursor at the point on the label where you want the barcode to appear.
2. Click or select Barcode from the Insert menu.
   The Barcode Settings dialog box appears.
3. Type the text you wish displayed as a barcode in the Data field.
4. Select the type of barcode from the Symbology drop-down menu.
5. Select whether you want the actual text to appear above the barcode, below the barcode or not at all under Human Readable Text.
6. If you selected above or below, click the Font button to choose the font for the text.
7. Select the size of the barcode under Barcode Size.
8. Click OK to insert the barcode on the label.

The barcode is placed on the label as a single object. To remove the barcode, you can use the backspace key or highlight the barcode and select Cut from the Edit menu.

Printing Vertically

You can print your label vertically, for example, to be placed on the spine of a binder or a video tape. When you print vertically, the text on your label is reformatted to fit in a single column on the label. You may wish to center the text on the label as well.

To print vertically

- Select the Vertical Label check box on the Formatting toolbar to select Vertical.
  The text of your label is now displayed in a single vertical column.
NOTE  If the contents of the label are too long to fit vertically on a fixed width label, the excess content is truncated. This action cannot be undone.

## Printing from Other Applications

The DYMO Label Software installation wizard installs a standard Windows printer driver on your computer so the DYMO LabelWriter Duo Tape printer will appear in your list of printers. This printer can be used to print directly from other applications, such as Microsoft Word or Access, in the same manner as you would use any other printer.

To successfully print to a DYMO tape printer, you need to set the correct page size, orientation, and margins for the tape cassette currently in the printer. Table 1 gives the paper size and margin settings for each of the label sizes supported by the DYMO tape printers.

### Table 1. DYMO Tape Printer Page Size and Margin Settings

<table>
<thead>
<tr>
<th>Paper Name</th>
<th>Paper Height</th>
<th>Paper Width</th>
<th>Top Margin</th>
<th>Bottom Margin</th>
<th>Left Margin</th>
<th>Right Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Label</td>
<td>1” (24 mm)</td>
<td>3.5” (89 mm)</td>
<td>0.23” (5.8 mm)</td>
<td>0.24” (6.1 mm)</td>
<td>0.4” (10.2 mm)</td>
<td>0.39” (9.9 mm)</td>
</tr>
<tr>
<td>Large Pendaflex</td>
<td>0.5” (12 mm)</td>
<td>3.5” (89 mm)</td>
<td>0.09” (2.3 mm)</td>
<td>0.10” (2.6 mm)</td>
<td>0.4” (10.2 mm)</td>
<td>0.39” (9.9 mm)</td>
</tr>
<tr>
<td>Small Pendaflex</td>
<td>0.5” (12 mm)</td>
<td>3.5” (89 mm)</td>
<td>0.09” (2.3 mm)</td>
<td>0.10” (2.6 mm)</td>
<td>0.4” (10.2 mm)</td>
<td>0.39” (9.9 mm)</td>
</tr>
<tr>
<td>1/3 File</td>
<td>0.5” (12 mm)</td>
<td>3.5” (89 mm)</td>
<td>0.09” (2.3 mm)</td>
<td>0.10” (2.6 mm)</td>
<td>0.4” (10.2 mm)</td>
<td>0.39” (9.9 mm)</td>
</tr>
<tr>
<td>1/5 File</td>
<td>0.5” (12 mm)</td>
<td>2” (51 mm)</td>
<td>0.09” (2.3 mm)</td>
<td>0.10” (2.6 mm)</td>
<td>0.4” (10.2 mm)</td>
<td>0.39” (9.9 mm)</td>
</tr>
<tr>
<td>6 mm Label</td>
<td>0.25” (6 mm)</td>
<td>3.5” (89 mm)</td>
<td>0.04” (1 mm)</td>
<td>0.04” (1 mm)</td>
<td>0.4” (10.2 mm)</td>
<td>0.39” (9.9 mm)</td>
</tr>
<tr>
<td>9 mm Label</td>
<td>0.375” (9 mm)</td>
<td>3.5” (89 mm)</td>
<td>0.03” (1 mm)</td>
<td>0.04” (1 mm)</td>
<td>0.4” (10.2 mm)</td>
<td>0.39” (9.9 mm)</td>
</tr>
<tr>
<td>12 mm Label</td>
<td>0.5” (12 mm)</td>
<td>3.5” (89 mm)</td>
<td>0.09” (2.3 mm)</td>
<td>0.10” (2.6 mm)</td>
<td>0.4” (10.2 mm)</td>
<td>0.39” (9.9 mm)</td>
</tr>
<tr>
<td>19 mm Label</td>
<td>0.75” (19 mm)</td>
<td>3.5” (89 mm)</td>
<td>0.11” (2.8 mm)</td>
<td>0.11” (2.8 mm)</td>
<td>0.4” (10.2 mm)</td>
<td>0.39” (9.9 mm)</td>
</tr>
<tr>
<td>24 mm Label</td>
<td>1” (24 mm)</td>
<td>3.5” (89 mm)</td>
<td>0.23” (5.8 mm)</td>
<td>0.24” (6.1 mm)</td>
<td>0.4” (10.2 mm)</td>
<td>0.39” (9.9 mm)</td>
</tr>
</tbody>
</table>

This section shows you how to print from within Microsoft Word to a DYMO tape printer. However, printing from applications other than Word follows the same basic steps.

### To print from Microsoft Word

1. Type the text to be printed into a Microsoft Word document.
2. Select **Print** from the **File** menu.
   - The Print dialog box appears.
3 Select the tape printer from the list of printers, if not already selected, and click Close.

4 Select Page Setup or Print Setup from the File menu.
   The Page Setup dialog box appears.

5 On the Margins tab, enter the margin values for the top, bottom, left, and right margins based on the labels you have loaded in the printer.
   Refer to Table 1 for the correct settings.

6 Click the Paper Size tab.

7 Select the label size you have loaded in the printer from the Paper size drop-down list.
   The width and height values should now match the values for that label size shown in Table 1.

8 Select Landscape under Orientation and click OK.

9 Click to print the label.

Print Settings
This section discusses several printer settings that may optimize your printing.

Tape Cassette Color Setting
Print settings on DYMO tape printers are based on the color of the label tape. To optimize the print quality, make sure you set the tape cassette color setting to match the color of the tape in the printer.

To set the tape cassette color
1 Select Tape Cassette Color from the Format menu.
   A list of possible tape color combinations appears.

2 Select the tape color combination that matches the tape cassette in the printer.
   Depending upon the selection you make, the background color in the main window may change so that you get a better idea of how your printed label will look.
Chain Printing

When printing multiple labels, the chain printing feature will automatically print a dashed cut-line between each label to indicate where each label should be cut.

You have the option of chain printing or automatically cutting each label after printing.

To change the chain print setting

1. Select Options from the Edit menu.
   The Options dialog box appears.

2. Select one of the following:
   - Cut each label as printed — Automatically cuts each label after printing.
   - Print cut marks between labels — Prints labels in a continuous stream with dotted lines between each label for cutting.

3. Click OK to apply the new setting.

Label Alignment

As a label is printed, blank space is added at the beginning of the label and at the end of the label. Normally, the space is the same on both ends of the label. However, you have the option of printing the label with less space at the beginning or at end of the label.

To change the label alignment

1. Select Options from the Edit menu.
The Options dialog box appears.

![Options dialog box](image)

2. Select an alignment from the **Label Alignment** drop-down list.

3. Click **OK** to apply the new setting.

**Continuous Mode Printing**

Continuous mode printing prints multiple labels with no space between the labels. This is especially helpful for conserving label tape. Continuous mode printing is turned off by default.

**NOTE** Continuous mode printing only applies to printing from other applications. This selection has no effect when printing from the DYMO Label Software. Continuous mode printing may not be available on all tape printers.

**To set continuous mode printing**

1. Right-click the tape printer from the **Printers and Faxes** control panel.
   
The printer option menu appears.

2. Select **Preferences**, and then **Advanced**.
The Advanced Options dialog box appears.

**NOTE** You can also get to this dialog box by selecting **Printer Setup** from the **File** menu.

3. Select **Enabled** from the **Continuous Paper** drop-down list and click **OK**.

The labels will now print continuously with no space between labels.
This chapter describes how to take care of your LabelWriter printer and offers suggestions for identifying problems that can occur when you using the printer. If you can’t solve a problem, this chapter also describes how to contact DYMO for technical support.

Caring for the LabelWriter Printer

The LabelWriter printer is designed to give you long and trouble-free service, while requiring very little maintenance. You’ll get the best possible performance from your LabelWriter printer if you follow the setup instructions that appear in the Quick Start Guide and the procedures described in this section.

You can easily clean your LabelWriter printer using the following items:

- Lint-free cloth.
- Isopropyl alcohol, diluted dishwashing detergent, or diluted glass cleaner. (If you use glass cleaner, make sure it does not contain ammonia.)
- Small, soft brush, such as a paint brush.
- LabelWriter cleaning card. One cleaning card (part number 60622) is included in your printer package. To purchase additional cleaning cards, visit www.dymo.com or call (800) 426-7827.

To keep your LabelWriter printer working properly, you should clean it from time to time. Dusting the outside of the printer occasionally will help keep foreign matter from getting inside the printer. However, it is still a good idea to periodically perform some basic interior maintenance.

**To clean the exterior and interior of your printer**

1. Turn off the printer and disconnect the power cord.
2. Use the lint-free cloth to wipe the exterior of the printer. Remove dirt and smudges with one of the cleaning solutions mentioned above.
3. Open the top cover.
4. Use a small, soft brush/cotton swab to whisk away paper dust and other stray particles from the inside of the printer.
5. Remove the roll of labels to clean under the roll.
6. If you have a LabelWriter cleaning card, follow the instructions printed on its packaging and feed it through the printer mechanism.
7. Reconnect the power cord and turn on the printer.
8. Reload the roll of labels and close the top cover.
Performing a Printer Self-Test

If you experience problems with broken characters or other print quality issues, you should perform a printer self-test. The self-test verifies that all elements of the print head are in working condition.

To perform a self test for the LabelWriter 300
1. Turn off the printer using the switch on the back.
2. Press and hold down the form-feed button.
3. Turn on the printer and then release the form-feed button.
   Your LabelWriter will print vertical lines along the width of the printer. To change the test pattern being printed, press the form-feed button.
4. To stop the self test, turn the printer off.

To perform a self-test for LabelWriter 320
1. Press and hold down the form-feed button on the front of the LabelWriter for 10 seconds.
   The LED light begins flashing red and green, and starts printing vertical lines along the width of the printer. The test pattern automatically changes every 3/4 inch (19 mm).
2. Release the form-feed button.
3. To stop the self-test, press and release the form-feed button.

To perform a self-test for the LabelWriter 330, 330 Turbo, 400, 400 Turbo, Twin Turbo, and Duo
1. Press and hold down the form-feed button on the front of the printer for 10 seconds.
2. Release the form-feed button.
   The printer will begin printing vertical lines along the width of the printer. The test pattern will automatically change every 3/4 inch (19 mm).
3. To stop the self-test, press and release the form-feed button.

Obtaining Technical Support

If you experience problems with the set up or use of your printer, carefully read this manual and consult the online Help to make sure you have not missed something that is covered in the documentation.

If you cannot resolve your problem by consulting the documentation, you can obtain additional information and assistance from DYMO.

Contacting DYMO

DYMO maintains an Internet Web site, www.dymo.com, that offers support for each printer. DYMO’s technical support department is also available by phone and fax between 9 A.M. and 8 P.M. Eastern time.

Web site: www.dymo.com
Phone: (203) 588-2500
Fax: (203) 588-2560 or (203) 355-7060
Visit the Support section of our Web site at www.dymo.com to contact us by e-mail.
Appendix A

Technical Specifications

This section gives the printer specifications for all the printers. You will also find information on DYMO’s Software Development Kit which will allow you to use the LabelWriter printer and software with your application.

**LabelWriter Printer Specifications**

<table>
<thead>
<tr>
<th></th>
<th>330</th>
<th>330 Turbo</th>
<th>310</th>
<th>320</th>
<th>400</th>
<th>400 Turbo</th>
<th>Twin Turbo</th>
<th>Duo a</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print Method</strong></td>
<td>Direct Thermal</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Print Resolution</strong></td>
<td>300 dots per inch (11.8 dots per mm)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Print Speed</strong></td>
<td>16</td>
<td>32</td>
<td>8</td>
<td>16</td>
<td>40</td>
<td>55</td>
<td>55</td>
<td>55</td>
</tr>
<tr>
<td>(labels/min for address label in text mode)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Maximum Print Width</strong></td>
<td>2.25&quot; 56 mm</td>
<td>2.25&quot; 56 mm</td>
<td>1.57&quot; 40 mm</td>
<td>2.25&quot; 56 mm</td>
<td>2.25&quot; 56 mm</td>
<td>2.25&quot; 56 mm</td>
<td>2.25&quot; 56 mm</td>
<td>2.25&quot; 56 mm</td>
</tr>
<tr>
<td><strong>Maximum Media Width</strong></td>
<td>2.44&quot; (62 mm) in all printers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Maximum Label Length</strong></td>
<td>User-definable</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Interface</strong></td>
<td>USB (USB Spec 1.1 protocol); Serial (Bi-directional, RS232) serial</td>
<td>USB (USB Spec 1.1 protocol)</td>
<td>USB 2.0 Full Speed Printer Class Device</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Dimensions (WHD)</strong></td>
<td>4 7/8&quot; (12.4 cm) x 5 3/4&quot; (14.6 cm) x 7 1/4&quot; (18.4 cm)</td>
<td>(183 mm) x (140 mm)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>1 1/2 pounds (0.68 kg)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(1.35 kg)</td>
</tr>
<tr>
<td><strong>Average Print Head Life</strong></td>
<td>2,000,000 linear inches (over 31 miles) 50800 linear meters</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Printer Power Requirements</strong></td>
<td>24 VDC 1.0 A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>24 VDC 1.75 A</td>
</tr>
<tr>
<td><strong>Rated Duty Cycle</strong></td>
<td>1000 labels</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1000 labels per side</td>
</tr>
<tr>
<td><strong>Regulatory Approvals</strong></td>
<td>CE, FCC, cTUVus, GS and C-Tick</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Warranty</strong></td>
<td>Two Year Limited</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

a. Label printer specifications
# Tape Printer Technical Specifications

<table>
<thead>
<tr>
<th></th>
<th>LabelWriter Duo (Tape Printer)</th>
<th>LabelManager PC II</th>
<th>LabelManager 450</th>
<th>LabelPoint 350</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print Method</strong></td>
<td>Thermal Transfer</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Print Resolution</strong></td>
<td>180 dpi (7.09 dots per mm)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Print Speed</strong></td>
<td>0.4&quot; (10 mm) per second</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Maximum Print Height</strong></td>
<td>0.71&quot; (18.1 mm)</td>
<td>0.71&quot; (18.1 mm)</td>
<td>0.71&quot; (18.1 mm)</td>
<td>0.53&quot; (13.54 mm)</td>
</tr>
<tr>
<td><strong>Maximum Media Width</strong></td>
<td>0.95&quot; (24 mm)</td>
<td>0.95&quot; (24 mm)</td>
<td>0.95&quot; (24 mm)</td>
<td>0.75&quot; (19 mm)</td>
</tr>
<tr>
<td><strong>Interface</strong></td>
<td>USB 2.0; Full Speed</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Dimensions (WHD)</strong></td>
<td>5.5&quot; (18.3 cm) x 7.8&quot; (19.8 cm) x 7.3&quot; (18.5 cm)</td>
<td>2.5&quot; (6.4 cm) x 5.3&quot; (13.3 cm) x 5.3&quot; (13.3 cm)</td>
<td>8.5&quot; (21.5 cm) x 9.6&quot; (24.5 cm) x 3.4&quot; (8.5 cm)</td>
<td>4.5&quot; (11.4 cm) x 8.4&quot; (21.2 cm) x 2.8&quot; (7.0 cm)</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>1 lb, 1 oz. (0.5 kg)</td>
<td>1 lb, 9 oz. (0.7 kg)</td>
<td>1 lb, 2 oz. (0.5 kg)</td>
<td></td>
</tr>
<tr>
<td><strong>Print Head Life</strong></td>
<td>Minimum 200 cassettes (7 meters each)</td>
<td>4,590 feet (1.4 km) of label tape</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Power Requirements</strong></td>
<td>24 VDC 1.0 A</td>
<td>9 V DC, 1.3 A</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Regulatory Approvals</strong></td>
<td>CE, FCC, cTUVus, GS and C-Tick</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Warranty</strong></td>
<td>Two Year Limited</td>
<td>One Year Limited</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Developer and SDK Information

DYMO provides various types of information designed to help developers create products that work with the LabelWriter printers and DYMO Label Software. Below are some notes for those interested in developing products that work with LabelWriter printers.

- Keep in mind that LabelWriter printers use standard printer drivers. Therefore, printing to a LabelWriter is no different than printing on a laser printer, except that the pages are smaller.
- In cases where you want to automate printing and take advantage of the label printing power built into DYMO Label Software, a Software Developer’s Kit (SDK) is included in your LabelWriter CD. The SDK provides OLE, direct DLL calls, and Dynamic Data Exchange (DDE) interfaces. For more information, visit www.dymo.com/developers.

You can check the Developer’s forum on the DYMO Web site at www.dymo.com/developers for the latest news. Also, you can join the Developer’s mailing list to obtain developer-specific news and announcements.

Documentation Feedback

We are constantly working to produce the highest quality documentation for our products. We welcome your feedback. Send us your comments or suggestions about our online Help, printed, or PDF manuals.

Please include the following information with your feedback:

- Product name and version number
- Type of document: printed manual, PDF, or online Help
- Topic title (for online Help) or page number (for printed or PDF manuals)
- Brief description of content (for example, step-by-step instructions that are inaccurate, information that requires clarification, areas where more detail is needed, and so on)
- Suggestions for how to correct or improve the documentation

We also welcome your suggestions for additional topics you would like to see covered in the documentation.

Send email feedback to:

documentation@dymo.com

Please keep in mind that this email address is only for documentation feedback. If you have a technical question, please contact Customer Service.
Appendix B

Printing Over a Network

This chapter describes how to print to a DYMO label printer over a network. The topics covered in this chapter are:

- “Printing to a Shared Printer from Windows”
- “Printing to a Shared Printer from Mac OS”
- “Using a Print Server”

The following are the general steps you need to follow to set up a printer for printing over a network. These steps are provided as a general overview and reminder that you must be able to print locally to the printer before you can share it.

The term local computer refers to the computer to which the printer is physically connected. The term remote computer refers to the computer from which you wish to print to a printer on the network.

NOTE When printing to a shared printer, any messages generated by the printer, including error messages, are displayed on the local computer, not on the remote computer.

To print to a shared printer over a network, the remote computer must be able to access the local computer over the network. Contact your System Administrator for more information.

1. Install the printer to be shared on the local computer.
2. Confirm that you can print to the printer locally.
3. Share the printer on the local computer.
4. Install the printer on the remote computer that will be printing to the shared printer.

See "Using a Print Server" on page 51 for information on printing through a print server.

Printing to a Shared Printer from Windows

This section describes how to print to a shared DYMO label printer in a Windows workgroup. For information on printing to a shared printer under Windows Server or other versions of Windows, see your Windows documentation or contact your System Administrator.

Sharing a Printer on a Network

These instructions assume that you have already installed DYMO Label Software on the local computer. See the printer’s Quick Start Guide for information.

Before printing to a shared printer from Windows, you first need to share the printer on the local computer.
To share the printer

1. Click **Start** and select **Printers and Faxes**.

   The Printers and Faxes control panel is displayed.

2. Right-click the printer you want to share and select **Sharing**.

   The DYMO label printer Properties dialog box is displayed with the Sharing pane open.

3. Select **Share this printer**.

4. Optionally, enter a different name for the printer in the **Share name** field.

   This is the printer name that appears to other users on the network.

5. Click **OK**. The share icon (hand) is displayed under the shared printer. This indicates that other users in the workgroup can print to this printer.

Installing a Network Printer

Before you can print to a shared network printer, you need to install DYMO Label Software (DLS) on your local computer and then add each network label printer you wish to use.

**NOTE** The LabelWriter Duo printer is actually two printers (label and tape) so you must run the Add Printer Wizard twice; once for the LabelWriter Duo label printer and once for the LabelWriter Duo tape printer.
To install a network printer using DLS Installer
1 Start the DYMO Label Software installation program. (See the Quick Start Guide for information.)
2 Follow the on-screen instructions to install the software.
3 When prompted to select the connection type, select Network (LAN) and click Next.
   A dialog box is displayed asking you to add the network label printer using the Windows Add Printer Wizard.
4 Click Next and then Finish.
5 Run Add Printer Wizard for each label printer you wish to use.

Printing to a Shared Printer from Mac OS

This section describes how to print to a shared printer in a Mac OS workgroup. For information on printing to a shared printer under other versions of Mac OS, see your Mac OS documentation or contact your System Administrator.

Sharing a Printer on a Network

These instructions assume that you have already installed DYMO Label Software on the local computer. See the printer’s Quick Start Guide for information.

Before printing to a shared printer, you first need to share the printer on the local computer.

To share the printer
1 Select System Preferences from the Apple menu.
   The System Preferences dialog box is displayed.
2 Double-click Print & Fax.
   The Print & Fax dialog box is displayed.
3 Select the printer you want to share and then click **Sharing**. The Sharing pane is displayed.

![Sharing pane](image)

**NOTE** To share the DMYO LabelWriter Duo printer, which can print on both labels and tape, select both the LabelWriter DUO Label and the LabelWriter DUO Tape 128 printers.

4 Select the **Share these printers with other computers** check box and then select the check box in front of each printer you wish to share.

5 Close the **Print & Fax** dialog box.

### Adding a Shared Printer

Before you can printer to a network printer, you need to install DYMO Label Software (DLS) on the remote computer. If you want to install more than one shared DYMO label printer, you must add each additional label printer.

**To install a shared network printer**

1 Install DYMO Label Software. (See the Quick Start Guide for information.)
2 From the Finder, select **Applications>Utilities>Printer Setup Utility.** The Printer List dialog box is displayed.
3 Click **Add.** The Printer Browser dialog box is displayed.
Using a Print Server

You can print over a network to a DYMO label printer connected to a wired or wireless USB print server.

A DYMO label printer works the same as any other printer connected to a print server and requires no special configuration. The steps for installing and printing with print servers vary by print server type and manufacturer. See the documentation provided with the print server for detailed installation and printing instructions.

DYMO label printers support printing from Windows XP (Service Pack 2), Windows 2000 (Service Pack 2), and Mac OS X.

The following are notes and tips for the print server installation:

- Make sure that your print server supports the type of operating system installed on your computer (Windows or Mac OS).
- The DYMO LabelWriter DUO printer does not currently support print servers. Contact DYMO technical support for more information.
- DYMO label printers with older firmware versions do not support print servers. See Printer Firmware Versions that Support Print Servers.

In general, during print server installation, if you are prompted for the printer or printer driver, select the option for installing a printer driver from a disk and insert the DYMO Label Software CD in the computer’s CD-ROM drive. If the installer doesn’t automatically locate the printer drivers, navigate to the printer drivers on the CD. If prompted to select your printer, select the printer physically connected to the print server.

To connect your label printer to a print server

1. Connect one end of a USB cable to the USB connector on your label printer and the other end to the USB connector on the print server.
2. Connect the print server to your network.
3. Connect power to the label printer and print server.
4. Install and configure the print server on your network.
5. Confirm that you can print to the label printer from the computer you are using to install and configure the print server.
6. Add the printer connected to the print server to other computers in the workgroup.
Printer Firmware Versions that Support Print Servers

Refer to the table below for information about the label printer firmware versions that support print servers. You can determine your printer’s firmware version by checking the serial number printed on the bottom of the printer.

<table>
<thead>
<tr>
<th>DYMO Label Printer Model</th>
<th>Serial Numbers Greater Than</th>
<th>Firmware Version Greater Than</th>
</tr>
</thead>
<tbody>
<tr>
<td>DYMO LabelWriter 400</td>
<td>xxxxx-2046321</td>
<td>93089v0T, 93490v0T</td>
</tr>
<tr>
<td>DYMO LabelWriter 400 Turbo</td>
<td>xxxxx-2096232</td>
<td>93176v0T, 93491v0T</td>
</tr>
<tr>
<td>DYMO LabelWriter Twin Turbo</td>
<td>xxxxx-2013955</td>
<td>93085v0M, 93492v0M</td>
</tr>
</tbody>
</table>

If your printer has firmware that does not support print servers, contact DYMO technical support for assistance on updating the printer’s firmware.
Index

A
ACT! Add-In 27
adding
  barcodes 35
  borders 31
  date and time 33
  graphics 34
  shared printer (Mac OS) 50
  special characters 32
  special fonts 32
address book
  About 17
  creating new 19
  opening lists 19
  rotating names 19
  using Mac OS address book 20
Address Fixer 20
address objects 14
  placing new 16
alignment, label 38

B
barcode objects 14
  placing new 16
barcodes, adding 35
BMP 34

C
chain printing 38
checking addresses 20
Codabar 15
Code 128 15
Code 39 15
contact managers
  ACT! 27
  GoldMine 27
continuous mode printing 39
counter objects 15
  placing new 16
creating a label 30
Creating a New List 19
curved text objects 15
date-time objects 15
  placing new 16
delimited files, printing 21
designer 13
designer toolbar 13
DYMO Label Software
  starting 7

E
EAN 8/13 15
elipse objects 14
EMF 34

F
fonts, special effects 32
form-feed button 42

G
GoldMine Add-In 27
graphic objects 14
  placing new 16
graphics, adding 34

H
help 2, 42
horizontal line objects 14
  placing new 16

I
Interleaved 2 of 5 15
Internet Postage 20
ITF-14 15

J
JPG 34

L
label alignment 38
Label Designer 13
  starting 13
label files 13
  opening 13
  saving 7
labels 13
  opening 15
  printing 11
  shelf life 2
  storage 2
LabelWriter printer
taking care of 41
line objects 14

M
Mac OS Address Book 20
main toolbar 13
Merge Print from Database 27
Microsoft
  Access 27
  Excel 26
  Outlook 26
  Word 25, 27
multi-line text 22

N
network printing 47

O
objects
  about 13
  address 14
  barcode 14
  counter 15
  curved text 15
  date-time 15
  ellipse 14
  graphic 14
  horizontal line 14
  placing new 16
  rectangle 14
  text 13
  vertical line 14
opening
  address book lists 19
  label files 7, 15
outline font 33
Outlook Add-In 25, 26

P
Palm Desktop 26
PCX 34
placing new objects on labels 16
PLANET 15
PNG 34
POSTNET 15
print server 51
print settings 37
  chain printing 38
  continuous mode printing 39
  label alignment 38
  tape cassette color 37
printer
  maintenance 41
  self-test 42
  specifications 43
  testing 42
printing
  chain printing 38
  continuous mode 39
  from a list 36
  labels 11
  multiple labels 23
  network 47
  vertically 35
Printing Internet Postage 20

R
rectangle objects 14
  placing new 16
register the software 2
Rotate Name 19

S
saving
  label files 11
  self-test 42
shadow font 33
sharing a printer
  Mac OS 49
  Windows 47
Smart Paste 21
spreadsheets, printing from 21
storing labels 2

T
tape cassettes
  color settings 37
technical support 42
text files, printing from 21
text objects 13
  placing new 16
thermal printing 1
TIF 34

U
UPC A/E 15
using
  print server 51
using with other programs 25

V
variable
  objects 18
  text objects 18
  vertical line objects 14
    placing new 16

W
WMF 34
Word Add-in 25
WordPerfect 26